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INTRODUCT ION

T
his book was born of the need for a simple yet engaging tutorial that would
help beginners step into the world of AutoCAD or AutoCAD LT without feel-
ing intimidated. That tutorial has evolved over the years into a full intro-
duction to the way in which architects and civil and structural engineers

use AutoCAD to increase their efficiency and ability to produce state-of-the-art
computerized production drawings and designs. 

Because AutoCAD and AutoCAD LT are so similar, it makes sense to cover the
basics of both programs. For most of the book, the word AutoCAD stands for both
AutoCAD and AutoCAD LT. 

When you come to a section of a chapter that applies to AutoCAD only, an
icon (shown here) is displayed in the margin to alert you. Then, at the end

of that section, extra information for AutoCAD LT users is provided to give you a
workaround or otherwise keep you in step with the tutorial. 

The appendix, which is an introduction to drawing in 3D, applies only to
AutoCAD, because AutoCAD LT does not have the 3D commands and features.
LT users, be assured: other than the 3D features, LT is much the same program
as AutoCAD, with minor differences. You’ll be prompted when those differences
come along.

This book is directed toward AutoCAD and AutoCAD LT novices—users who
know how to use a computer and do basic file-managing tasks, such as creating
new folders and saving and moving files, but who know nothing or little about
AutoCAD or LT, as we’ll be calling AutoCAD LT throughout the book. If you are
new to the construction and design professions, this book will be an excellent
companion as you’re learning AutoCAD. If you’re already practicing in those fields,
you’ll immediately be able to apply the skills you’ll pick up from this book to
real-world projects. The exercises have been successfully used to train archi-
tects, engineers, and contractors, as well as college and high-school students,
in the basics of AutoCAD.

For those of you in other trades and professions, the project that runs through
the book—drawing a small cabin—has been kept simple so that it does not require
any special training in architecture or construction. Also, most chapters have
additional information and exercises specifically designed for non-AEC users. So
anyone wanting to learn AutoCAD will find this book helpful.

�

A note like this will
provide you with
information on
AutoCAD LT, as well
as other helpful
information.
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What Will You Learn from This Book?
Learning AutoCAD, like learning any complex computer program, requires a signifi-
cant commitment of time and attention and, to some extent, a tolerance for repeti-
tion. You must understand new concepts to operate the program and to appreciate its
potential as a drafting and design tool. But to become proficient at AutoCAD, you
must also use the commands enough times to gain an intuitive sense of how they
work and how parts of a drawing are constructed.

At the end of most chapters, you will find one or more additional exercises and a check-
list of the tools you have learned (or should have learned!). The steps in the tutorial have
a degree of repetition built into them that allows you to work through new commands
several times and build up confidence before you move on to the next chapter.

Progressing through the book, the chapters fall into four general areas of study:

� Chapters 1 through 3 familiarize you with the organization of the screen,
go over a few of the most basic commands, and equip you with the tools
necessary to set up a new drawing.

� Chapters 4 and 5 develop drawing strategies that will help you use com-
mands efficiently.

� Chapters 6 through 11 work with AutoCAD’s major features.

� Chapters 12 through 14 and the Appendix examine intermediate and
advanced AutoCAD features.

In the process of exploring these elements, you will follow the steps involved in lay-
ing out the floor plan of a small, three-room cabin. You will then learn how to gener-
ate elevations from the floor plan and, eventually, how to set up a title block and print
your drawing. Along the way, you will also learn how to do the following:

� Use the basic drawing and modify commands in a strategic manner

� Set up layers

� Put color into your drawing

� Define and insert blocks

� Generate elevation views

� Place hatch patterns and fills on building components

� Use text in your drawing

� Dimension the floor plan

I n t r o d u c t i o nx v i

4341FM.qxd  4/19/04  17:32  Page xvi



Chapters in the last part of the book touch on more advanced features of AutoCAD,
including:

� Drawing a site plan

� Using external references

� Setting up a drawing for printing with layouts

� Making a print of your drawing

� Working in three dimensions, for AutoCAD users

All these features are taught using the cabin as a continuing project. As a result, you
will build up a set of drawings that document your progress through the project and
that you can use later as reference material if you find that you need to refresh your-
self with material in a specific skill. 

At the end of the book is a glossary of terms that are used in the book and are related
to AutoCAD and building design, followed by an index.

Files on the Website

If you are already somewhat familiar with AutoCAD and reading only some of the chap-
ters, you can pull accompanying files for this book from Sybex’s website at www.sybex
.com. Use the Catalog or Search tool to find this book’s web page, and then click the
Downloads button.

Also on Sybex’s website, in addition to the .dwg files that accompany the book, you
can download a bonus chapter, “Making the Internet Work with AutoCAD” and a bonus
appendix, “An Introduction to Attributes.” These introduce you to tools for working
online with AutoCAD and demonstrate a method for defining attributes and construct-
ing a title block using attributes, respectively.

Hints for Success
Because this book is essentially a step-by-step tutorial, it has a side effect in common
with any tutorial of this type. After you finish a chapter and see that you have progressed
further through the cabin project, you may have no idea how you got there and are sure
you couldn’t do it again without the help of the step-by-step instructions.

This feeling is a natural result of this kind of learning tool, and you can do a couple
of things to get past it. You can do the chapter over again. This may seem tedious, but
it has a great advantage. You gain speed in drawing. You’ll accomplish the same task
in half the time it took you the first time. If you repeat a chapter a third time, you’ll
halve your time again. Each time you repeat a chapter, you can skip more and more of

I n t r o d u c t i o n x v i i
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the explicit instructions, and eventually you’ll be able to execute the commands and
finish the chapter by just looking at the figures and glancing at the text. In many ways
this is just like learning a musical instrument. You must go slow at first, but over time
and through practice, your pace picks up.

Another suggestion for honing your skills is to follow the course of the book, but
apply the steps to a different project. You might draw your own living space or design
a new one. If you have a real-life design project that isn’t too complex, that’s even bet-
ter. Your chances for success in learning AutoCAD or any computer program are greatly
increased when you are highly motivated, and a real project of an appropriate size can
be the perfect motivator.

Ready, Set…
When I started learning AutoCAD about 17 years ago, I was at first surprised how long
I could sit at a workstation and be unaware of time passing. Then, shortly afterward, I
experienced a level of frustration that I never thought I was capable of feeling. When I
finally “got over the hump” and began feeling that I could successfully draw with this
program after all, I told myself that I would someday figure out a way to help others
get over the hump. That was the primary motivating force for writing this book. I hope
it works for you and that you too get some enjoyment while learning AutoCAD. As the
title says, there is “No experience required,” only an interest in the subject and a will-
ingness to learn!

I n t r o d u c t i o nx v i i i
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CHAPTER 1

Getting to Know
AutoCAD
� Opening a new drawing

� Getting familiar with the AutoCAD and AutoCAD LT Graphics
windows

� Modifying the display

� Displaying and arranging toolbars
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Y
our introduction to AutoCAD and AutoCAD LT begins with a tour of the
features of the screens used by the two programs. In this chapter, you will
also learn how to use some tools that help you control the screen’s appear-
ance and how to find and start commands. For the material covered in this

chapter, the two applications are almost identical in appearance. Therefore, as we
tour AutoCAD, I’ll point out any differences between AutoCAD and AutoCAD LT. In
general, LT is a 2D program, so it doesn’t have the 3D features that come with
AutoCAD, such as solids modeling and rendering. The other differences are minor.
As mentioned in this book’s Introduction, when I say “AutoCAD,” I mean both
AutoCAD and AutoCAD LT. I’ll also refer to AutoCAD LT as “LT” throughout this
chapter and the rest of the book. Starting up AutoCAD is the first task at hand.

Starting Up AutoCAD
If you installed AutoCAD or LT using the default settings for the location of the pro-
gram files, start AutoCAD by choosing Start ➣ All Programs ➣ Autodesk ➣ Auto-
CAD 2005 ➣ AutoCAD 2005. For LT, choose Start ➣ All Programs ➣ Autodesk ➣

AutoCAD LT 2005 ➣ AutoCAD LT 2005. If you customized your installation, find
and click the AutoCAD 2005 or the AutoCAD LT 2005 icon to start the program.

The Startup Dialog Box
If AutoCAD or LT opens with the Startup dialog box sitting in front of the Auto-
CAD Graphics window, your screen will look like Figure 1.1. If the Startup dialog
box doesn’t open, read on a little—you’ll see how to display it and then how to
suppress it.

The Startup dialog box has four buttons in the upper-left corner. The first two
buttons let you set up a new drawing and choose an existing drawing to revise or
update. The second two buttons use templates and wizards to initiate advanced
setup routines. The contents of the middle portion of the dialog box depend on
which of the four buttons you choose. By beginning a new drawing, you can get
past this dialog box to the AutoCAD Graphics window.

1. Click the Start From Scratch button, the second button from the left.

2. In the Default Settings section, click the Imperial (Feet And Inches)
radio button.

3. Click OK to close the Startup dialog box. Your monitor displays the
AutoCAD or LT Graphics window, sometimes called the Graphical
User Interface, or GUI (see Figure 1.2).

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D2

�

Dialog boxes with
various combinations
of buttons and text
boxes are used exten-
sively in AutoCAD
and LT.You will learn
their many functions
as you progress
through the book.

�

Radio buttons are
round and come in a
list or a group.You
can activate only one
radio button at a time.
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F I G U R E  1 . 1 :  The Startup dialog box

F I G U R E  1 . 2 :  The AutoCAD Graphics window

Title bar Menu bar Drawing area Standard toolbar Properties toolbar

Crosshair cursor

Model and Layout tabsUser Coordinate
System icon

Draw toolbar Modify toolbar Status bar Command window

Layers toolbar

S t a r t i n g  U p  A u t o C A D 3
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N O T E If the New Features Workshop window appears when you start
up AutoCAD, click the second or third radio button in the window, and then
click OK to remove it. You can always access it on the Help menu.

The toolbars on your screen may not be in exactly the same places as they are
shown in Figure 1.2. I recommend that you set your screen to look like the one
here, as it will make following through the book that much easier. Later in this
chapter, you will see how to move the toolbars, display new ones and place them,
and delete them.

Another feature called palettes might be visible on the far-right side of your
screen when you start AutoCAD. Palettes can display as a rectangular area or as a
vertical title bar. If they appear, choose Tools ➣ Tool Palettes Window to tem-
porarily close the palettes. We’ll take a look at them in Chapters 7 and 9.

CONTROLL ING THE WAY AUTOCAD STARTS UP

You can set AutoCAD and LT to display or hide the Startup dialog box when
you start AutoCAD.

1. From the menu bar, choose Tools ➣ Options to open the Options dia-
log box.

2. Click the System tab to bring it forward.

3. In the General Options section, open the Startup drop-down list.

� If you want AutoCAD to display the Startup dialog box, click Show
Startup Dialog Box.

� If you want AutoCAD to start up with a blank drawing, click Do
Not Show A Startup Dialog.

4. Click Apply, and then click OK.

The next time you start up AutoCAD, your preference will be used.

C h a p t e r  1  •  G e t t i n g  t o  K n o w  A u t o C A D4
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Introduction to the AutoCAD 
Graphics Window
At the top of the Graphics window sit the title bar, the menu bar, and three
toolbars.

The title bar is analogous to the title bar in any Windows program. It contains
the program name (AutoCAD or AutoCAD LT) and the title of the current draw-
ing with its path. Below the title bar is the menu bar, where you will see the
drop-down menus. Among the drop-down menus, the first two on the left and
the last one on the right are Windows menus (meaning that they appear on most
Windows applications). These Windows menus also contain a few commands
specific to AutoCAD. The rest of the menus are AutoCAD menus.

Below these menus is the Standard toolbar, which contains 22 command but-
tons (LT has only 21). Several of these buttons will be familiar to Windows users;
the rest are AutoCAD commands. Just below the Standard toolbar are the Layers
toolbar and the Properties toolbar, which together contain three command but-
tons and five drop-down lists.

The blank middle section of the screen is called the drawing area. Notice the
movable crosshair cursor. The crosshairs on your cursor may not extend com-
pletely across the screen. I recommend that you set them to look like they do in
the figures in this book, and I will show you how to do this when we make a few
changes later in this chapter.

Notice the little box at the intersection of the two crosshair lines. This is one
of several forms of the AutoCAD and LT cursor. When you move the cursor off
the drawing area, it changes to the standard Windows pointing arrow. As you
begin using commands, it will take on other forms, depending on which step of a
command you are in.

The icon with a double arrow in the lower-left corner of the drawing area is the
User Coordinate System icon. It indicates the positive direction for the X and Y
coordinates. You won’t need it for most of the chapters in this book, so you’ll
learn how to make it invisible in Chapter 3.

Title bar Menu bar Standard toolbar Properties toolbarLayers toolbar 

I n t r o d u c t i o n  t o  t h e  A u t o C A D  G r a p h i c s  Wi n d o w 5

�

The title bar and
menu bar at the top
of the LT screen are
identical to those of
AutoCAD except that
AutoCAD LT appears
in the title bar rather
than AutoCAD.
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At the bottom of the drawing area are three tabs: a Model tab and two Layout
tabs. You use these tabs to switch between viewing modes. (I’ll discuss viewing
modes in Chapter 13.) Our example shows no toolbars floating in the drawing
area, but there are two docked toolbars at the left of the drawing area. Your
screen may or may not have the toolbars, or they may be in a different position.
If the toolbars are within the drawing area, they will have a colored title bar. For
specifics, see the section “The Toolbars” later in this chapter.

Below the drawing area is the Command window.

The Command window is where you tell the program what to do and where the
program tells you what’s going on. It’s an important area, and you will need to
learn how it works in detail. Three lines of text should be visible. If your screen
displays fewer than three lines, you will need to make another line or two visible.
You’ll learn how to do this later in this chapter in the section “The Command
Window.”

Below the Command window is the status bar.

Toolbars Drawing area

Crosshair cursor

User Coordinate
System icon Model and Layout tabs
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On the left end of the status bar, you’ll see a coordinate readout window. In the
middle are eight readout buttons (LT has only seven) that indicate various drawing
modes. It is important to learn about the coordinate system and most of these
drawing aids (Snap, Grid, Ortho, and Osnap) early as you learn to draw in Auto-
CAD or LT. They will help you create neat and accurate drawings. Polar and Otrack
are advanced drawing tools and will be introduced in Chapter 5. Lwt stands for
Lineweight and will be discussed in Chapter 14 in the discussion on plotting. The
Model button is an advanced aid that will be covered in Chapter 13. At the far right
of the status bar are small icons that indicate the presence of various features for a
drawing session. These features are beyond the scope of this book.

This has been a quick introduction to the various parts of the Graphics win-
dow. I didn’t mention a couple of items that might be visible on your screen. You
might have scroll bars below and to the right of the drawing area, and you might
have a menu on the right side of the drawing area. Both features can be useful,
but they can also be a hindrance and can take up precious space in the drawing
area. They won’t be of any use while working your way through this book, so I
suggest that you remove them for now.

To temporarily remove these features, follow these steps:

1. Choose Tools ➣ Options to open the Options dialog box (shown in
Figure 1.3). It has nine tabs (LT has only eight) across the top that act
like tabs on file folders.

F I G U R E  1 . 3 :  The Options dialog box
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2. Click the Display tab, which is shown in Figure 1.4. Focus on the rec-
tangular area titled Window Elements. If scroll bars are visible on the
lower and right edges of the drawing area, the Display Scroll Bars In
Drawing Window check box will be checked.

F I G U R E  1 . 4 :  The Options dialog box open at the Display tab

3. Click the check box to turn off the scroll bars. Also click the Display
Screen Menu check box to turn off the screen menu. Don’t click the
OK button yet.

Another display setting that you might want to change at this point controls
the color of the cursor and the drawing area background. The illustrations in
this book show a white background and black crosshair cursor, but you might
prefer to reverse the colors. To do so, follow these steps:

1. In the Window Elements area of the Display tab, click the Colors
button to open the Color Options dialog box (see Figure 1.5). In the
middle of the dialog box, in the Window Element drop-down list box,
Model Tab Background should be visible. If it’s not, open the drop-
down list and select it.
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F I G U R E  1 . 5 :  The Color Options dialog box

2. Move to the Color drop-down list, which is below the Window Ele-
ment drop-down list. If your drawing area background is currently
white, a square followed by the word White is displayed. Open the
Color drop-down list. Scroll to Black (or the background color you
want) and select it. The drawing area will now be that color, and the
cursor color will change to white, as shown in the Model Tab preview
window in the upper-left corner of the dialog box.

3. Click the Apply & Close button to close the Color Options dialog box.

4. Don’t close the Options dialog box yet.

5. If you want the lines of your crosshair cursor to extend completely
across the screen, go to the lower-left corner of the Display tab
(lower-right for LT) and move the slider to change the Crosshair
Size setting to 100. 

6. Click OK to close the Options dialog box.

Your screen and crosshair cursor will take on their newly assigned colors, and
the crosshair lines should extend across the drawing area.

T I P If you choose a color other than black as the drawing area back-
ground color, the color of the crosshair cursor remains the same as it was
(black). To change the crosshair color, in the Color Options dialog box, open
the Window Element drop-down list, and select Model Tab Pointer. Then select
a color from the Color drop-down list.
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The Command Window
Just below the drawing area is the Command window. This window is actually
separate from the drawing area and behaves like a Windows window—that is,
you can drag it to a different place on the screen and resize it, although I don’t
recommend that you do this at first. If you currently have fewer than three lines
of text in the window, you will need to increase the window’s vertical size. To do
so, move the cursor to the horizontal boundary between the drawing area and
the Command window until it changes to an up-and-down arrow broken by two
parallel horizontal lines.

Hold down the left mouse button and drag the cursor up by approximately the
amount that one or two lines of text would take up, and then release the mouse.
You should see more lines of text, but you might have to try this a couple of
times to display exactly three lines. When you close the program, the new set-
tings will be saved, and the next time you start up AutoCAD, the Command win-
dow will display three lines.

The Command window is where you give information to AutoCAD and where
AutoCAD prompts you for the next step in executing a command. It is a good
practice to get into the habit of keeping an eye on the Command window as you
work on your drawing. Most errors occur when you are not taking a look at it
frequently.

Before you begin to draw, take a close look at the menus, toolbars, and key-
board controls.

N O T E In many cases, you can start AutoCAD commands in a number of
ways: from drop-down menus, from the toolbars, and from the keyboard.
When you get used to drawing with AutoCAD, you will learn some shortcuts
that start commands quickly, and you will find the way that is most comfort-
able for you.
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Drop-Down Menus
The menu bar, just below the title bar (see Figure 1.2 earlier in this chapter),
consists of 11 words and an icon. Click any of these to display a drop-down
menu. The icon on the left end and the File and Edit menus are included with all
Windows-compatible applications, although they are somewhat customized to
work with AutoCAD. The menu associated with the icon contains commands to
control the appearance and position of the drawing area.

Commands in the File menu are for opening and saving new and existing
drawing files, printing, linking on the Internet, exporting files to another appli-
cation, choosing basic utility options, and exiting the application. The Edit menu
contains the Undo and Redo commands, the Cut and Paste tools, and options for
creating links between AutoCAD files and other files. The Help menu (the last
menu on the right) works like all Windows Help menus and contains a couple of
AutoCAD-specific entries as well, including some online resources and a context-
sensitive help feature called the Info Palette.

The other eight menus contain the most-often-used AutoCAD commands. You
will find that if you can master the logic of how the commands are organized by
menu, you can quickly find the command you want. Here is a short description
of each of the other AutoCAD drop-down menus:

View Contains tools for controlling the display of your drawing file.

Insert Contains commands for placing drawings and images or parts of them
inside other drawings.

Format Contains commands for setting up the general parameters for a new
drawing.

Tools Contains special tools for use while you are working on the current
drawing, such as those for finding the length of a line or for running a special
macro.

Draw Contains commands for creating new objects (such as lines or circles) on
the screen.

Dimension Contains commands for dimensioning a drawing.

Modify Contains commands for changing existing objects in the drawing.

Window Contains commands for displaying currently open windows and lists
currently open drawing files.
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